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MIDI Made Music for Windows
LLERRAH Inc.'s MIDI Made Music for Windows is a full featured jukebox player for
use on your Windows 3.1, Windows 95, or Windows NT 4.0 PC and the Internet.

Special features include:
· Plays MIDI, Wave, Microsoft Video, Apple Quicktime Video, MPEG Video, MPEG Audio, AU, 

SND, AIFF and CD-Audio formats
· Add up to 10,000 of your own selections to the Jukebox
· Supports queueing of multimedia files
· Load multimedia files off the Internet into the Jukebox database
· Create song, CD-audio and video clips using custom edit feature
· Assign your own editors in the Jukebox for Music and Video files
· Random and Repeat play
· Create personal play lists of your favorite selections
· Windows 95 Long Filename Support
· Search database function
· Playlist Editor for all mulitmedia file types
· Speed up or slow down songs and videos by changing Tempo
· Customize animation settings for the Jukebox

LLERRAH Inc. develops Windows based Multimedia software and custom MIDI songs to 
meet individual, business, and educational needs.    For more information contact:

LLERRAH Inc.
2701    W. 15th St.    Suite 631
Plano,    TX    75075
EMAIL Address: llerrah@dfw.net
WEB Site: http://www.dfw.net/~llerrah



File Menu
The File menu includes commands that enable you to load multimedia files to the Playlist or 
save files in the Playlist.

For more information, select the File menu command name.

Load to Play List
Edit and Save Play List
Exit



Options Menu
For more information, select the Options menu command name.

Add, Delete, Copy, Move Groups
Find Selection
Random Play
Repeat Play
Color Schemes
Specify Editors
Animation
Drag and Drop New Selections
Hide Menu

Advanced Options:
Use Simple Time Bar
Copy Playing Selection to Jukebox
Delete Playing Selection File
Register File Types to Use Jukebox
Enable Low Resource Mode
Enable ability to delete files from Playlist



Modify Menu
The Modify menu includes commands that enable you to modify group names, selection 
information, and your Multimedia configuration.

For more information, select the Modify menu command name.

Name of Current Group
Selection 1 to 10

The following are only available in Windows 3.1:
Microsoft MIDI Mapper
Multimedia Drivers
System Sounds

The following are only available in Windows 95 or NT 4.0:
Multimedia Properties
Volume Control



MIDI Devices Menu
Select MIDI Devices from the menu to get a list of all MIDI devices currently installed on 
your PC.    You should always use the default, MIDI Mapper, when playing any of the MIDI 
Made Music songs.    Other MIDI devices listed are primarily intended for use when playing 
songs not designed for Windows.    You can play MIDI Made Music songs using the other 
MIDI devices but they may not produce the intended sound.

For best results, use the MIDI Mapper.    See the section on Microsoft MIDI Mapper for more 
information.



CD Audio Menu
If you have a CD-ROM drive on your computer, the MIDI Made Music Jukebox player can 
play music tracks from your audio CDs.    First, insert your audio CD into your CD-ROM player.
Next, select CD-Audio from the main menu and pick either Play All Tracks (F3) or Select 
Tracks to Play (F4).    Select Tracks to Play allows you to pick the individual CD tracks 
you wish to be added to the Playlist.    While the CD track is playing, you can use the Time 
Scroll bar to move forward or backward within the CD track.    

**You CANNOT change the tempo of a CD audio track.** 

NOTE: You must have previously installed the Windows CD-Audio drivers from your Windows 
diskettes in order to play CD music.

Attention Windows 95 Users:    You can configure Windows 95 CD-Audio to 
AUTOMATICALLY play your audio CDs using the MIDI Made Jukebox by doing the following 
steps:    

From the Jukebox menu select: Options - Advanced Options - Register 
File Types to use Jukebox - CD Audio to use Jukebox

Now insert an Audio CD into your computer CD player.    The Jukebox should 
automatically add the CD tracks to the Playlist and start playing the selections if you 
are running Windows 95.



Setting up the Sound Board or MIDI device

If you have not already done so, you need to install the Windows 3.1 Multimedia Extensions 
drivers for your sound Board or MIDI device.    Drivers and installation instructions are 
provided by the manufacturer of your sound board or MIDI device.    On most sound boards, 
the installation program configures everything needed to run MIDI Made Music for Windows 
without modification.    If you have any problems with the operation of your sound board, be 
sure to check to see if you have the latest drivers from your board manufacturer.

Refer to the Microsoft MIDI Mapper section if you have problems or questions on the 
operation of your Sound Board with MIDI Made Music.



MIDI File Information

All of the MIDI song files contained in MIDI Made Music for Windows were authored to 
Microsoft Windows 3.1 Multimedia Extensions guidelines.    These guidelines call for two 
performances of each song to be included in a MIDI file.    One performance for higher end 
sound boards and keyboards (MIDI channels 1 through 10) and one performance for lower 
end sound boards (MIDI channels 13 through 16).    This enables the same MIDI file to be 
played on a wide variety of sound boards and MIDI devices without being modified.    Most 
sound board installation programs configure Windows for either high end or low end 
operation.



Just What is MIDI
MIDI is the acronym for Musical Instrument Digital Interface.    MIDI was developed in 
1982 and has become the international standard for digital music.    MIDI defines a 
communications protocol and the hardware interface required to connect different types of 
musical instruments together.

MIDI enables synthesizers, sequencers, home computers, rhythm machines, etc...to be 
interconnected through a standard interface.    Microsoft Windows 3.1, Windows 95 and 
Windows NT provide standard support for MIDI capable instruments and hardware.



Creating Song and Video Clips using Custom Edit

MIDI Made Jukebox gives you the capability to easily create your own custom song and video
clips.    Song clips are created by modifying existing songs to change start and stop times as 
well as tempo.    For example, you could create a 10 second clip of Scott Joplin's "Maple Leaf 
Rag" by specifying that only the first 10 seconds of the song play.    Whenever you play this 
new song clip you will hear only the first 10 seconds of Maple Leaf Rag.

When creating a song clip, it is recommended that you first add a new song to the Jukebox.    
Since the song clip is a new version of an existing song, it should be treated as a whole new 
song.

To create a custom song clip, select Modify - Number of selection to modify from the 
menu or click the Right Mouse Button on the desired selection Icon.    If no file has been 
specified, then select a song using the Browse button.    Next, select the Custom Edit 
button which brings up the custom edit display.

The Custom Edit display has sliding controls to allow you to specify new start and end times 
as well as a new tempo.    To specify a new start or stop time, use your mouse to move the 
sliding controls to the desired times. The tempo is changed in the same way by using your 
mouse to slide the tempo control to the desired tempo value.

If custom editing a Video clip, you can specify a start and stop time, the playback tempo and
the size and location to playback the video.    Use your mouse to position the video playback 
windows to the desired size and location on your screen.

MIDI Made Music Jukebox Player will not use the your custom edit song modifications 
unless you activate them by selecting the Activate User-defined Start and Stop 
Times ,the Activate User-Defined MIDI Tempo Settings or the Activate User Defined 
Video Settings. 

Use the Defaults button to reset start and stop times, tempo values, and video settings 
back to their original values. Select the OK button once you have finished customizing the 
song.

For detailed steps, see Example of Creating a Song Clip



Glossary

clipboard



Loading Media Files and Play Lists

To load one of your Personal Play Lists or a MIDI,Wave,Microsoft Video or Apple Quicktime 

Video file, select File-Load to Play List from the menu or select the     button in the 
upper right hand corner of the main screen.    Select any of the files ending in .MMJ to load 
and choose OK.    The list of selections in the .MMJ file will be added to the PLAYLIST.    You 
can load any other multimedia file types to the playlist as well. 



Edit and Save Play List

Play Lists are collections of your favorite MIDI, Wave, Audio, Videos or CD-Audio selections.  
You can Edit and Save Play Lists to files for later playing.    Edit and save a Playlist by doing 
the following steps:

1.      Add selections to the PLAYLIST then select File-Edit and Save Playlist.    While in the 
Playlist editor you can add additional selections, changes selection names and icons, and re-
order the playing.
2.      Save your Play List by clicking the SAVE button.    The saved playlist will be a file ending 
in a .MMJ extension.      



Exit Command

When the Exit command is selected, MIDI Made Music Jukebox player stops playing the 
current selection and ends the program.    If any changes have been made, then you will be 
prompted to save them.



Random Play

Random play does just what the name implies, it randomly plays selections from the MIDI 
Made Music Jukebox player.    Random play is activated by selecting menu commands, 
Options - Random Play, or by pressing the F9 key.    When active, [Random] appears in the
Title bar.    

Note:    Random play only works if there are NO selections in the PLAYLIST.    That is, after all 
selections in the list have finished, then Random play begins.



Repeat Play

Repeat play also does just what the name implies, it repeatedly plays all the selections 
currently in the PLAYLIST.    Repeat play is activated by either selecting it from menu 
Options - Repeat Play or by pressing the F10 key.    When active, [Repeat] appears in the 
Title bar.    For example, if    two songs are in the PLAYLIST, then those same two songs will 
play over and over again.



Add, Delete, Copy, Move Groups

MIDI Made Music Jukebox player supports up to 1000 selection groups.    Each group 
contains 10 selections for a total of 10,000 selections.    You can add groups to the MIDI 
Made Music Jukebox player in order to save your own multimedia files or playlists.    By 
using the Cut, Copy, Paste keys, you can re-order the groups.



Drag and Drop New Selections

Windows File Manager or Windows 95 My Computer can be used to easily add new selections
to the Jukebox and Playlist.    From the menu, select Options - Drag and Drop New 
Selections which will bring up the Drag and Drop Options.    You can select to add Drag and 
Drop files to either the Jukebox, Playlist or both.

Example:    To add a MIDI to the MIDI Made Music Jukebox player, do the following:
1) Bring up Windows File Manager or Windows 95 My Computer.
2) Locate a MIDI file (*.MID,*.RMI).
3) Move your mouse pointer over the file and hold down the left mouse button.
4) While holding down the mouse button, drag the mouse pointer over to the MIDI 

Made Music Jukebox Player and drop the file.    That's It!



Animation

The MIDI Made Music Jukebox player allows customization of the two animation display 
areas.    To modify Animation settings, select Options - Animation from the menu or press 
your Right Mouse button over one of the animation areas.

By default the current 10 selection ICONS float over the Treble Clefs.    If you click your left 
mouse button on one of the moving ICONS, then you will see the ICON change as well as 
hear a sound.    MIDI Made Music Jukebox player allows you to change mouse click 
actions, the number of ICONS displayed, the animation background and even create a 
moving background.

Have fun playing with the animation options!



Specify Editors

You can define your own multimedia editors that can be called by clicking 
the "User Defined Edit" button located on the Modify Selection screen.

This features allows you to easily edit selections in the jukebox database using your favorite 
MIDI, Wave or Video editor.

An example of an editor would be the Microsoft Sound Recorder "SOUNDREC.EXE" 
to edit *.WAV files for Windows 3.1 users.      Windows 95 users would use "SNDREC32.EXE".



Regular Time Bar

If checked, the non-ICON version of Time bar will be displayed. 

If not checked, the ICON version of the TIME bar will be displayed.



Hide Jukebox Menu

This option hides the Jukebox menu from display.      

You can restore the Jukebox menu by double-clicking on the top Title bar or by clicking
on the top left hand corner of the Jukebox and selecting the Hide Menu option.



Modify Name of Current Group

Modify the name used to describe the currently displayed group of 10 selections.



Copy Selection to Jukebox

This feature allows you to copy the MIDI, Wave or Video selectiona to the Jukebox database.

New selections will be added to the current group of 10 selections if space is available.    If all
10 selections are used then a new group will be created.

Example Use: If you have downloaded a new Jazz MIDI file from the Internet and would like 
to add it to the Jukebox. Next if the song is in the Playlist then highlight it and click the Copy 
button.    You can also press the F5 key to copy the song currently playing.    You can then 
optionally enter information about the MIDI file like song name or change the icon.    The 
MIDI file will be copied to the directory of your choice.        

The Copy Selection to Jukebox operates as follows:

1. Select Group to copy selection to or Add a new group.

2. Add or change Selection Title    

3. Optionally pick a different ICON that will be associated with the selection by choosing the
ICON button.

4. Enter the Destination Filename or pick Browse to select the directory to save the file. 
NOTE:    The directory must already exist.

5. Optionally enter information about the selection.

6. Click the OK key to add the new selection.      Click Cancel to abort adding the new 
selection.



Modify Selection Information

The Selection Information can be added or modified as follows:

1) Modify Selection Title

2) Enter the Filename or pick Browse to locate a .MID, .WAV, .AVI or .MOV file type.

3) Optionally pick an ICON that will be associated with the selection by choosing the 
ICON button.

4) Optionally enter information about the selection.

5) Optionally perform a Custom Edit on a MIDI(.MID,.RMI), Wave(.WAV), Microsoft 
Video (.AVI) or Apple Quicktime VIdeo (.MOV) file to modify playing times, tempo 
or video playback location.

6) Optionally perform a User Defined Edit to call one of your own Multimedia editors.

The DELETE button will remove the selection reference from the jukebox but WILL NOT 
delete the actual selection file.

The Next Selection button will save the current settings and take you to the next selection 
in the current group.



Modify Multimedia Drivers

This option will bring up the Windows Drivers control panel which is used to install, 
remove, and configure drivers that control additional devices, such as sound cards and video
players.



Multimedia Properties

This option will bring up the Windows 95 Multimedia Properties program which allows 
you to adjust MIDI, Audio, Video and CD-ROM settings for Windows 95.



Volume Control

This option will bring up the Windows 95 Volume Control application that will allow you to
adjust volume for MIDI, Wave and CD-Audio.



Delete Playing Selection File
If a media selection is currently playing, this option will prompt you to delete the file 
associated with the selection.



Find Selection
Allows you to seach the jukebox database to locate any multimedia selections.      Find will 
search the following fields: Selection Title, filename, and selection information.



Register File Types to Use Jukebox

This option allows you to register multimedia file types to use the Jukebox whenever they 
are opened.      For example if you register MIDI files to use the Jukebox, then if you are in the
File Manager displaying a directory of MIDI files, just double-click your mouse on a MIDI file 
to have it load into the Jukebox.



Enable Low Resource Mode
This option is recommended for use only on Pentium computers.

When this option is selected, the jukebox will reduce the use of Windows resources on your 
PC.    This is done by displaying ICONS in a different manner which is slightly slower but 
consumes less Windows resources.



Enable ability to delete files from Playlist

When this option is enabled, the Delete button for the main Jukebox screen or playlist editor 
will display a prompt asking the user if they want to delete the file associated with this 
selection.

The default (unchecked) action of the delete key is to remove the entry from the Jukebox but
NOT delete the file.



Modify System Sounds

This option will bring up Windows System Sounds control panel which is used to assign 
sounds to different system and application events. For example, you can select a sound to 
play whenever you start Windows. The sounds you can assign are stored in files that have 
the .WAV extension. 



Modify Color Scheme Used

The MIDI Made Music Jukebox player provides 3 pre-defined color schemes to select from.
You may also select Windows defaults to use you own color scheme.



Playing Controls

The following lists a summary of the playing controls available on the MIDI Made Music 
Jukebox player main screen.    Short-cut keys are listed in parenthesis( ).    

To modify a selection, click your right mouse button on top of the selection ICON.

Play All (A) Add current group of 10 selections to the Playlist

Load to Playlist Select media files to load to Playlist.

Edit and Save Playlist Modify playlist before saving.

Next (N)      Play next selection in Playlist or play highlighted selection

Delete (D) Delete the next or highlighted selection in the Playlist

Clear(C) Clear all selections in Playlist

Edit(E) Edit the next or highlighted selection in the Playlist  

Modify(M) Modify the next or highlighted selection in the Playlist

Loop(L) Loop the playing of the current selection

Copy(Y) Copy the next or highlighted selection in the Playlist to the Jukebox      

Pause (P) Pause the playing of the current selection.

Rewind(R) Rewind the playing of the currently selection 

Stop (S) Stop the playing of the current selection

Play (S)        Start playing the next selection from the Playlist.



1 to 10 (Use 0 for 10) Add Jukebox selections to the Playlist.

Change Time (T) Use mouse or arrow keys to change the current position.

Change Tempo (O) Use mouse or arrow keys to change the current tempo of the MIDI song
or Video playing.    Note:    You cannot change the Tempo of .WAV files or CD-Audio track.

F2- Repeat Last Move last played selection to Playlist.

F3 - All CD Tracks Add all CD Tracks to the Playlist.

F4 - Select CD Tracks Select which CD tracks to add to the Playlist.

F5 - Edit Groups Add, Delete, Copy, Move Groups.

F6 - Find Selection Search the Jukebox ( Ctrl - F )

F7 - Previous Group Change to the previous group of selections

F8 - Next Group  Change to the next group of selections

F9 - Random Play Randomly play all selections in the jukebox.

F10 - Repeat Play Play all selections in the Playlist over and over again.



Information on Microsoft's MIDI Mapper

Microsoft's MIDI Mapper is a software device built into Windows 3.1 and above that provides 
means for device-independent playing of MIDI music.    This allows MIDI music to produce its 
intended sound when played through different types of sound boards, keyboards, and other 
musical instruments.    All of the MIDI songs in MIDI Made Music were designed to play 
through the MIDI Mapper.

Luckily, you do not need to understand the MIDI Mapper to be able to use it.    Most sound 
boards correctly configure the MIDI Mapper when you install the Windows 3.1 Multimedia 
Extensions drivers for that sound board.

Generally, you should never have to edit any parameters in the MIDI Mapper unless you 
have an external keyboard connected to a MIDI port on your PC.    You will have to contact 
your keyboard manufacturer to get instructions on how to modify the MIDI Mapper to work 
correctly with your keyboard.    

If you do edit parameters in the MIDI Mapper, then it is best to make a backup copy of the 
MIDIMAP.CFG file located in your WINDOWS\SYSTEM directory.    In case you incorrectly 
configure the MIDI Mapper, the backup will provide a way to restore the original values.
 
To start the MIDI Mapper select Modify - Microsoft MIDI Mapper from the Jukebox menu.

One point to remember when working with the MIDI Mapper is that all MIDI Made Music 
songs contain two performances of the same song in one file.    You will need to have either 
channels 1 through 10 active for extended level synthesizers or channels 13 through 16 
active for base level synthesizers.    You do not want to have all channels active when playing
MIDI Made Music, this might result in a less than desirable sound.



Example of Creating a Song Clip

The following shows the steps needed to create and add a custom song clip to the MIDI 
Made Music Jukebox player.    This example will perform a custom edit on Scott Joplin's 
"Maple Leaf Rag."

1.      First add a new group of 10 selections to the Jukebox by selecting Options - Create 
New Group of 10 Selections from the menu.

2.      Next select Modify - MIDI Selection 1 from the Menu to add a new song.

3.      Use the Browse button to locate the song we want to customize.    The Maple Leaf Rag 
MIDI file is named MAPLE.MID.    Give the song a title if you wish.    In this example we will call
our new song "Maple Leaf Rag Clip."

4.      Select the Custom Edit button to make the song modifications.

5.      Use your mouse or keyboard to set a new start time of 35.64 and a new stop time of 
49.43.    These times determine where the new song clip should start and stop.

6.      Use your mouse or keyboard to set a new tempo value of 270.    This will speed up the 
playing of the Maple Leaf Rag Clip and make it sound more lively.

7.      Select Activate User-Defined Start and Stop Times and select the Activate User-
Defined Tempo Setting.    Select OK to save your custom edit song settings.

8.      The new values for start and stop times and tempo will be displayed next to the Custom
Edit button on the Modify Information display.    This informs you which custom settings the 
song will be using.

9.      Select the OK button to add your song clip to the MIDI Made Music Jukebox player.

10.      You are finally    ready to play your new song clip by simply selecting the new 
selection's ICON button on the main MIDI Made Music Jukebox player display.    Upon 
exiting the MIDI Made Music Jukebox player be sure to save your changes in order to 
keep your new song clip.



Adding Selections to the Jukebox

You can add your own selections to the MIDI Made Music Jukebox player with a few 
simple steps.    From the menu select Modify - Number of selection to modify or click 
your right mouse button on the selection ICON.    You will be prompted to enter a Selection 
Title, pick an ICON, and enter the full path name of the MIDI, Wave, Microsoft Video or Apple 
Quicktime Video file.    You can optionally fill in the selection information field as well as 
performing a Custom Edit of the selection

To add or change the selection filename, you will need to select the Browse button.    This 
will bring up a window that will allow you to locate a MIDI, Wave, Microsoft Video or Apple 
Quicktime Video file to be added to the Jukebox.    After you have entered a valid file name 
and Title then select OK to update the Jukebox.    Be aware that the changes made are not 
permanent unless you save changes when you exit MIDI Made Music Jukebox player.

You can also add selections to the Jukebox database using Drag and Drop or the copy 
selection feature.



Locations to Obtain Video Drivers
Playing Microsoft Video, Apple Quicktime Video or MPEG video files requires that you install 
special software drivers.    These drivers are available from the MIDI Made Music Internet 
WEB page located at the following address:

http://www.dfw.net/~llerrah



Deleting Selections from the Jukebox
To delete a selection from the MIDI Made Music Jukebox player, select from the menu 
Modify - Selection number to delete.    Select Delete to delete all the text associated with
the selection.    Then select OK which will delete the reference to the selection.    



Last Played

Displays list of 20 selectons last or most recently played.        Use your mouse or keyboard to 
select one of the selections in the list which will then be added to the Playlist.

NOTE: If the Jukebox is setup for Repeat play then no selections will be added to the Last 
Played menu.    They will automatically be re-added to the Playlist.
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